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1. SAR CALCULATOR APPLICATION OVERVIEW 
The SAR Calculator has been designed to assist SAR practitioners with search planning 
calculations, in accordance with accepted Search and Rescue procedures and practices. 
The application should be used in conjunction with standard operating procedures and 
should not be considered the primary source for the SMC decision making process. 
The SAR Calculator has been developed using the methodologies adopted in the Australian 
National Search and Rescue Manual. 
 

The SAR Calculator is designed to run on the Microsoft Windows environment. The software 
has been tested on Operating Systems (OS) using version 4 of the .Net Framework or later. 
The software may have problems running on earlier versions of the .Net framework. 
The SAR Calculator and SARC_Map applications are designed for 96 DPI display settings 
(100% font size). Display issues may result for DPI settings greater than 96. To adjust or 
check the DPI configurations consult the OS display settings. 
For installation simply Drag & Drop the SAR Calculator folder from the USB drive to the 
desired location on your PC (i.e. My Documents Folder, Operational Network Drive etc.). 
Alternatively the application can be run from the USB drive itself. To start the application 
double click on the “SAR Calculator.exe” file. 
The design concept of the SAR Calculator is to provide a portable, uncomplicated 
application that operates in a stand-alone environment with no reliance on external 
databases that allows for quick and precise calculations in place of manual SAR worksheets. 
 

 

On start-up the application loads a Floating Window that 
presents the user with a quick access menu to the different 
modules and functionalities of the program. The Floating Menu 
is designed to be relatively unobtrusive and can be positioned 
anywhere on the users screen, where it will by design stay on 
top of all other active windows. 
 

To access the different modules simply click on the desired 
menu item. Depending on the element either a new window will 
be opened to allow access to the module or a list will be 
presented with various calculators and tools that can be 
double-clicked on to activate. 
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TIPS & TECHNIQUES 
 

COORDINATES 
A number of the modules require input of Latitude and Longitude for positional reference. 
The application requires the following formatting for this coordinate system; 
Latitude  

 Degrees Minutes & Decimals of minutes (6 digit) 
 Ranging from 0 degrees at the equator to 90 degrees at the poles 
 Hemisphere Reference (N = north, S= south)  
 i.e. 25 15.30 S 

Longitude 
 Degrees Minutes & Decimals of minutes (7 digit) 
 Ranging from 0 degrees at the prime meridian to 180 degrees at anti meridian 
 Direction Reference Greenwich (E=east, W=West) 
 i.e. 135 54.24 E 

 

DATE TIME 
A number of the modules require input of a Date-Time group (DTG). The application requires the DTG to be entered as per the computer system settings format;  
Formatting: d=day, M=month, y= year, h=hour, m=minutes  
Example:   16th Feb 2016 @ 09:17UTC 

AUS/UK: “dd/MM/yyyy hh:mm”  =  “16/02/2016 09:17” 
USA:  “MM/dd/yyyy hh:mm”  =  “02/16/2016 09:17” 

 
 

ICONS 
 Opens an interactive calculator tool 
 Performs a calculation and returns the applicable results  
 Resets the module ready for a new calculation 
 Opens Target Selector 
 Solution Wizard 

 Opens Interactive SAR Light Calculator 
 Opens Interactive Time Calculator 

  Toggle to set floating window status (right click form to access context menu) 
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MENU ITEMS 
In each of the main modules is a Menu strip which provides access to certain functions and tools. The Menu is a consistent throughout the application and is comprised of the following;   

 File menu 
 New  - starts a new calculation 
 Open  - opens an existing calculation 
 Save  - saves the current working calculation 
 Save As - saves a copy of the current working calculation 
 Close  - exits the module  

 Tools menu 
 Provides access to a range of tools or functions to assist in the calculation type 

 
 Solutions menu 

 PDF / Text File / Print – Exports the results of the calculation to the document type 
selected; 
  Send to        

 Coords - sends the calculation result to the Coords module (generate search 
legs and waypoints) 

 SARC_Map File – sends the calculation result to a mapping file that can be 
opened and viewed in the SARC_Map application 
  Solution Wizard – guides through the creation of a comprehensive SAR solution 
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2. MARITIME DRIFT MODULE 
The Maritime Drift module is designed to perform the complex calculations associated with 
Worksheet 1 in the National Search and Rescue Manual, providing the user with a drifted 
maritime search area based on the parameters for a particular target, time and 
environmental conditions. For a comprehensive understanding of drift planning please 
consult the National Search & Rescue Manual (NATSARMAN). 
 

    
 

    

Access to the Maritime Drift Module is 
achieved by clicking on the ‘Maritime Drift’ 
menu item on the SAR Calculator floating 
window. 
Select from the two Drift Calculation options 
available; 
 Oceanic Drift (refer to section 4.7 of the 

National SAR Manual) 
 Coastal Drift (refer to section 4.8 of the 

National SAR Manual) 
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User Guide 
 To start a new Drift Calculation select ‘New’ from the File menu and select a  drift 

calculation type (oceanic or coastal); 
 Click on the Target icon to select the applicable target (note: target leeway & 

current factors are imported on selection);  

 
 Enter the last known position (LKP) of the target : Latitude and Longitude 
 Enter the LKP date time group 
 Enter the time UTC that the search will commence 
 Optional: Enter the time that the search is planned to conclude (leave blank for basic 

radius area / sector search)  
 Complete the average Sea Current Direction and Speed fields 
 Complete the average Wind Direction and Speed fields 
 Set the Error Factors in accordance with NATSARMAN Appendix J 
 Optional: Check / Uncheck the Wind Current Applied (by default this is not applied) 
 Click on the Process button to perform the Drift Calculation 
Results 
The Maritime Drift module will provide the following results; 
 Search Area Radius (in nautical Miles based on the Calculated Datum);or 
 Search Area Shape (based on the Calculated type) 
 Search Area Square Nautical Miles 
 The Calculated Search Area Datum for the target that the above results are based  

 
Note: 
To drift Route instead of a Datum open the route editor, complete the applicable fields and 
check the ‘Drift as Route’ checkbox. Apply navigation errors (dre) in accordance with the 
recommendations in NATSARMAN Appendix J 
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Solution Menu Options 

 
 

 Drift Plot: Creates a comprehensive Drift Plot calculation report that can be printed or 
saved as a PDF or text document 

 Send to: The calculation can be sent to the Coords module, where the Search area can 
be developed. The plot can also be sent to a SARC-Map file to be viewed in the SAR 
Calculator mapping application (SARC_Map). 

 Solution Wizard: Guides the SAR practitioner through a number of the SAR Calculator 
modules to complete a comprehensive SAR plan solution. 
 

 
Oceanic Drift Plot Solution Example (print Version) 

Tools 
 

 

 
 

 
 

 

 The Drift Module provides the option to either drift a Datum or a Rout which is accessed by the Route Editor tool.  
 The Last Light and Time Difference calculators interact with the module to assist in determining hours of drift to be applied to the search plan.  
An average Wind Calculator is available to determine the mean wind effect over the drifted time period, should the winds over the duration be known to have had variances in magnitude.  
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3. LAND PLOT 
The Land Plot module is designed to perform the functions of the Worksheet 4 calculations, 
as contained in the National Search and Rescue Manual. This module allows for the 
development of a single point datum based plot or for a two point datum plot to construct a 
route trapezoid search area. Additionally a stage 2 Route Buffer area can be created in this 
module. For a comprehensive understanding of search planning please consult the National 
Search & Rescue Manual (NATSARMAN). 
 

  
 

User Guide – Single Point Datum 
1. Select New from the File Menu and select the Stage 3 option; 
2. Enter the LKP Latitude / Longitude (Deg Min Dec) 
3. Enter the LKP DTG; 
4. Enter the applicable Fix Errors in accordance with Appendix J (NATSARMAN); 
5. Select an appropriate Safety Factor (default 1.1) 
6. Click on the Process button to generate results.  
 
 

Access to the Land Plot module is achieved by clicking on the ‘Land Plot menu item on the SAR Calculator floating window.  Two calculation options are 
available to choose from; 
 Stage 3:  (Circle of Probability around a datum and Route Trapezoid  
 Route Buffer: (Stage 2 Area)  
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Results – Single Point Datum 
The Land Plot module will provide the following results; 
 Search Area Radius (in nautical Miles based on the Calculated Datum) 
 Search Area Square Nautical Miles based on the search radius (a boxed up 

calculation is also provided) 
 The Calculated Datum for the target that the above results are based on. 

 

  
 
 
 
 
 
 

 
Route Editor 

Note: Checking / unchecking the “Calculate as a Route” checkbox determines whether calculating a Route or a single point Datum (based on the LKP). 

User Guide – Multi Point Datum  
(Route Trapezoid) 
1. Select New from the File Menu and 
select the Stage 3 option; 
2. Enter the LKP Latitude / Longitude; 
3. Enter the LKP DTG; 
4. Click on the Route button to open the 
Route Editor. Enter the route details 
either as Lat/Long coordinates or 
Bearing/Distance and click apply; 
5. Enter the applicable Fix Errors in 
accordance with NATSARMAN Appendix 
J; 
6. Select an appropriate Safety Factor 
(default 1.1) and Navigation (dre) error 
(default 10%); 
7. Click on the Process button to 
generate results.  
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Results – Multi Point Datum (Route Trapezoid) 
The Land Plot module will provide the following results; 
 Search Area dimensions (average of sides of the trapezoid) 
 Search Area Square Nautical Miles based on the multiple datum’s associated with a 

route trapezoid 
 Search Radius for the start datum and final point datum  
 
 

 
 
Results – Route Buffer (Stage 2 area) 
The Land Plot module will provide the following results; 
 Search Area dimensions (based on the route distance and buffer parameters) 
 Search Area Square Nautical Miles 
 The centre coordinated of the route with before and after buffers applied. 
 
 
 

User Guide – Route Buffer  
1. Select New from the File Menu and 
select the Route Buffer option; 
2. Enter the Waypoint coordinates 
(Latitude / Longitude) for the start 
and end locations of the route; 
3. Enter the LKP DTG; 
4. Enter the buffer parameters to be 
applied around the route (standard 
10nm either side, 5nm before and 
after) 
5. Click on the Process button to 
generate results.  
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Solution Menu Options 

 
 
 Search Area Plot: Creates a Plot calculation report that can be printed or saved as a 

PDF or text document 
 Send to: The calculation can be sent to the Coords module, where the Search area can 

be developed. The plot can also be sent to a SARC-Map file to be viewed in the SAR 
Calculator mapping application (SARC_Map). 

 Solution Wizard: Guides the SAR practitioner through a number of the SAR Calculator 
modules to complete a comprehensive SAR plan solution. 
 

 
Route Trapezoid Plot (print version) 
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4. AVIATION SEARCH 
The Aviation Search module is designed to perform the Worksheet 2 (maritime targets) and 
Worksheet 3 (Aviation / Land targets) calculations, as contained in the National Search and 
Rescue Manual. The Aviation Search module works in conjunction with the Track Space 
Calculator (covered in detail later) and returns the optimal Search Area Coverage and 
Probability of Detection results, and presents a number of compromise options that can be 
considered by the user. For a comprehensive understanding of search planning please 
consult the National Search & Rescue Manual (NATSARMAN). 
 

Access to the Aviation Search module is achieved by clicking on the ‘Aviation Search’ menu item 
on the SAR Calculator floating window. 
 

 
 

User Guide 
1. Select New from the File Menu; 
2. Enter appropriate details in the Track Space Calculator; 
3. Select desired search height / track spacing and click apply; 
4. Enter the Search Area details (SQNM) and Available Search Hours; 
5. Click on the Search Compromise calculator icon to generate results.  
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Section Description 
Search Criteria: 
Results imported from the Track Space Calculator based on the target, search platform and 
environmental parameters entered.  

 
Clicking the Calculator Icon will open the Track Space calculator for editing.  

 
 
Search Parameters: 
The size of the search and available search hours allow the module to calculate the Search 
Compromise results.  

 
Clicking the Calculator Icon will open a Search Hour Conversion Calculator to help 

determine search hours at an equivalent speed of 120 knots.   
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Search Compromise: 
Provides the results based on details entered above. If there is not enough search hours 
available to complete the area then a number of compromise options are generated for the 
user to consider.  

 
 Clicking the Calculator Icon will return the search parameter and compromise results.  

 
Solutions: The completed Worksheet can be printed or saved as a PDF document. 
 
Edit Menu Options 
 

 Search Criteria: opens the track space calculator with the current data for editing 
 Increment: sets the track space increment to be calculated for the compromise 

options. The Default increment is set at 0.25nm 
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5. MARITIME SEARCH 
The Maritime Search module is designed to perform the Worksheet 8 calculations, as 
contained in the National Search and Rescue Manual. The Maritime Search module works in 
conjunction with the Track Space Calculator (covered in detail later) and returns the optimal 
Search Area Coverage and Probability of Detection results, and presents a number of 
compromise options that can be considered by the user. For a comprehensive 
understanding of search planning please consult the National Search & Rescue Manual 
(NATSARMAN). 
 

Access to the Maritime Search module is achieved by clicking on the ‘Maritime Search’ menu 
item on the SAR Calculator floating window. 
 

 
 

User Guide 
1. Select New from the File Menu; 
2. Enter appropriate details in the Track Space Calculator; 
3. Select desired search height / track spacing and click apply; 
4. Enter the Search Area details (SQNM) and Available Search Hours; 
5. Click on the Search Compromise calculator icon to generate results.  
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Section Description 
Search Criteria: 
Results imported from the Track Space Calculator based on the target, search platform and 
environmental parameters entered.  

 
 

Clicking the Calculator Icon will open the Track Space calculator for editing.  

 
 

 

Search Parameters: 
The size of the search and available search hours allow the module to calculate the Search 
Compromise results.  

 
 

Clicking the Calculator Icon will open a Search Hour Conversion Calculator to help 
determine search hours at an equivalent speed of 10 knots.   
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Search Compromise: 
Provides the results based on details entered above. If there is not enough search hours 
available to complete the area then a number of compromise options are generated for the 
user to consider. 

 
 Clicking the Calculator Icon will return the search parameter and compromise results.  

 
Solutions: The completed Worksheet can be printed or saved as a PDF document. 
 
Edit Menu Options 
 

 Search Criteria: opens the track space calculator with the current data for editing 
 Increment: sets the track space increment to be calculated for the compromise 

options. The Default increment is set at 0.25nm 
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6. COORDS 
The Coords module is used to create and edit search areas, apply search legs and to 
generate the waypoint coordinates for the search pattern. 
 Search areas can be created or imported into the Coords module.  
 The following options are available when creating search areas; 

 Radius and Search Datum (square or round areas); 
 Manual (square, rectangle or trapezoid areas); 
 Route Buffer (square or rectangle areas); 
 Trackline Search (expanding leg or offset leg) 

 
The following search patterns can be applied to the search areas; 

 Parallel Leg; 
 Bounded Area; 
 Sector Search (Radius and Datum search area only). 

Search areas can be imported from the Maritime Drift and Land Plot modules by using the 
“Send to” solution method. 
Components 
  Calculated / Estimated Driftline:  

Assists in determining the search leg alignment 
Note: calculated target drift is imported with Maritime Drift module search areas 
  Search Area Orientation: 
Stipulates the orientation of the search area in degrees true as measured from 
coordinate 1 to 2; 
The orientation can be amended for square and radius based search areas;  
Orientation is imported with Maritime Drift module search areas and is automatically 
aligned with the target drift 
  Track Spacing 
Track spacing for search legs can be entered for parallel and sector search patterns  
For sector searches the track space refers to a Mean Track Spacing 
  Search Leg Alignment 
The alignment of the search legs can be amended to best suit the search plan 
  Direction of Turns 
Nominates the direction of turn between search legs for the sector search pattern 

Search Area Graphical Display  
 Show Drift / Show Legs checkboxes control whether the Driftline and Search Legs are 

displayed 
 The number of parallel search legs displayed are indicative only and are primarily for the 

purpose of determining the search leg alignment 
 Rectangular and Trapezoid search area shapes may not be to scale and/or displayed 

proportionally, however the output solutions (waypoints, SAR solution and SARC_Map 
file) will all be accurate. 
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Solutions 
A list of coordinates and search leg waypoints can be generated from the Solutions menu. 
The coordinates can be printed or saved to a PDF or text file document or sent to a GPX file. 
The search area coordinates and search leg waypoints can be sent to a SARC_Map file for 
viewing in the SAR Calculator mapping application (SARC_Map). 

   
     Parallel Search Pattern     Sector Search Pattern 
 

 
Sector Search Waypoint List 
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7. ALLOCATION EDITOR 
The Allocation Editor is used to assign search legs or bounded search areas to SAR units. 
Allocations can be generated for either Maritime or Aviation search platforms. 

 
AVIATION ALLOCATION  

Note: The Allocation Editor is only accessible from the Coords Module via the Solutions 
Menu and only after the search area has been saved. 
Allocation Editor Toolbar 
The toolbar provides an orderly process for creating an allocation and generating 
briefings. 

  Saves the Allocation details to the associated Coords file 
  Reloads the last saved Allocation  

 Adds a row for a new SAR Unit (aviation or maritime as appropriate) 
 Task Editor Tool - performs system automation functions 

 Sets the Search Commencement time 
 Access to the SAR Light Calculator 
 Access to the Fuel Calculator (Aviation Allocation only) 
 Creates a Mapping file (to view in the SARC_Map tool) 
 To access / edit the search summary notes 
 Generates a PDF SAR Unit briefing 

 Generates a GPX file containing the assigned search waypoints 
 Deletes the selected the SAR Unit 
 Deletes all SAR Units in the allocation 
 Exit the Allocation Editor 
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User Guide to creating an allocation 
 Open / create a search area in the Coords Module and select Allocation from the Solutions Menu 
 Select the desired search platform for the allocation (aviation or maritime) 
 Enter the time that the search is planned to commence 
 From the Toolbar add a new SAR Unit  
 Complete the data Fields as appropriate (i.e. callsign, search speed endurance etc.) 
 Select a Task type from the dropdown list 
 Double-click in the Search Legs / Datum cell to allocate search legs to the SAR unit 
 Click in the Task Notes cell to add specific task notes for the selected SAR unit 
 Repeat above for all other SAR unit tasks 
 From the Toolbar click on the Search Summary icon to enter details about the search that will be included in all SAR unit briefings 
 From the Toolbar click the Map icon to create and view the SAR unit task in the Mapping application 
 From the Toolbar click on the PDF icon to generate a comprehensive briefing the selected SAR unit 
 From the Toolbar click on the GPX icon to create a waypoint file for the selected SAR unit  
Task Types 
 The Task Types is dependent on the type of search area that was sent to the Allocation 
Editor from the Coords Module. The task types available are; 
  Parallel Leg   - for search areas that have search legs applied - search legs can be shared amongst SAR units 
 Bounded Area - for search areas that do not have search legs applied - the bounded area can be sub-divided to assign to multiple SAR units 
 Sector Search - for search areas created as Sector search   - search legs can only be assigned to one SAR unit 
 Trackline Search - for search areas created as Trackline search   - search legs can only be assigned to one SAR unit 
 Comms Relay  - additional activity available for Aviation allocations only  - can only be assigned to one SAR unit 
 OSC   - additional activity available for Maritime allocations only  - can only be assigned to one SAR unit 
Task Editor Tool  
 The Task Editor Tool provides functions to assist in the creation an allocation. 
The Task Editor Tool is search type dependent, providing features appropriate to the task.  
The two main features are; 
 Automation of search leg allocation  Splitting a bounded search area into multiple sub-areas 

 
Following is a brief explanation of the Task Editor Tool for Parallel Leg and Bounded Area 
search types. 
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Parallel Leg ~ System Allocate 
To utilise this function first add all SAR units to the allocation, set their parameters (search speed and endurance) and set the appropriate task from the dropdown list. 
From the Toolbar select the Task Editor Tool icon and click on the System Allocate item. Search legs will be assigned to all SAR units that have been set with a Parallel task. 
The following rules apply if the allocation is based on a Parallel Leg search area; 
  Search legs will be allocated in the order that was designated in the Coords Module (starting at the search leg alignment location); 
 Where possible an equivalent number of search legs will be allocated to each SAR unit; 
 The number of search legs will be limited to the on-scene endurance of the SAR unit.  
To clear the allocated select Clear All from the menu. 

           Parallel Leg             Bounded Area 
 
Bounded Area ~ Sub-Areas 
This function allows the bounded search area to be sub-divided into multiple areas, which can then be shared / allocated to multiple SAR units. 
From the Toolbar select the Task Editor Tool icon and click on the Set Sub-Area item. The following editing window will be displayed. Select the appropriate number of areas to split the search area into and select apply. 

   
Double click in the Search Area/Datum cell of the desired SAR unit to allocate with bounded area. The following window will be displayed to select the preferred area from. 

 
 
Comms Relay / OSC 
SAR units assigned with Comms Relay or OSC tasks will be automically located adjacent to the search area for the endurenace of the search (limited to the units on-scene endurance). The datum for the task can manually be overwritten if prefered. 
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Search Summary Editor 

 

 
Allocation Mapping View  

 
SAR Unit PDF Briefing Document 
 The briefing document that is generated from the Allocation Editor contains the following 
information; 
 The search summary and communications plan; 
 A list of appropriate search objects; 
 Search Area First and Last Light (UTC); 
 Task Details, including type of search, designator, search height and entry/exit points; 
 Task Notes specific to the SAR Unit being briefed; 
 Waypoints List; 
 Search Plan Snapshot; 
 SAR Task Debrief Form. 
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8. SOLUTION WIZARD 
The Solution Wizard guides and integrates a number of the SAR Calculator modules to 
produce a comprehensive SAR Solution.  
Starting the Wizard 

  
The five stages of the Solution Wizard are; 

 Create the Search Area:  Maritime Drift / Land Plot Module 
 Search Parameters:  Air/Maritime Search Module 
 Search Pattern Coords:  Coords Module 
 Search Plan Solution:  PDF SAR Solution 

  Wizard Icons 
  After processing the necessary data at each stage the Wizard Wand will appear 

to allow access to the next stage  
 Clicking on the Wizard Ball will provide tips for progressing at each stage of the 

solution 
 Press the return arrow to go back to the previous stage of the solution 

 Click on the Door at any stage to exit the wizard 
 

The Solution Wizard can be accessed from the Maritime Drift and the Land Plot modules through the Solutions menu.  
 

 Click on the Wizard Wand to Progress Stages 
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SAR Solution 
The SAR Solution is generated in a PDF document and contains the following 
information; 
 Target Details and Description 

User defined input 
 

 Search Area Modelling Data 
Imported from the Maritime Drift/ Land Plot modules 
 

 Search Parameters 
Imported from the Track Space Calculator & Aviation / Maritime Search modules 
 

 Search Area Details 
Imported from the Coords module 
 

 Search Area First & Last Light 
Calculated for the centre of the search area for the day the solution is created 
 

 Search Area Snapshot 
Captured through integration with the SARC_Map application (if available) 
 

 Search Leg Waypoint List 
Generated by the Coords module (option to also generate a GPX file) 
 

 Allocation 
Option to save the Coords data to allow an Allocation to be created 

Handling of Search Compromise – reduction in Area 
Search area compromise is achieved by reducing the radius of a Square or Sector search area by the factor of the total area selected. In doing this the search datum always remains the centre of the search area and only the extremities are trimmed. 
For Route Trapezoid searches each of the calculated circles of probability are reduced by a factor that results in achieving the approximate compromise sqnm selected. In doing this the datum’s are retained in the search area while the bounds of the area are trimmed. 
For the Route Buffer search the compromise is applied to the buffer either side of track element, resulting in the bounds of the area being trimmed whilst always retaining the route within the search area.  
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9. CALCULATORS 
This module provides access to a variety of calculators to assist the SAR practitioner.  
Included are; 
 ATVS Calculator 
 Track Space Calculator (Aviation and Maritime) 
 Intercept & Escort 
 Grid Convertor 
 Cumulative POD Calculator 
 Fuel Endurance Calculator 

 

  
 
 
 
 
 
 
 
 
 
 

Access to the Calculator module is achieved by 
clicking on the ‘Calculator’ menu item on the SAR 
Calculator floating window. A list of calculators will 
be presented. Double clicking on a desired calculator 
will open it in a separate window. 
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ATVS CALCULATOR 
SAR Formula: A=T.V.S 

A= Area (SQNM) 
T= Time (search hours) 
V = Velocity (knots) 
S = Track Spacing (nautical miles) 

 

Given any three of the above values the ATVS calculator can be used to find the 4th value. 
 
User Guide 
 Select the unknown value to calculate from the drop-down menu 

 
 Enter the know values in the remaining fields 

  
 Click on the Calculate button to return the result 

 Note: If one of the dimensions of the search area is known and entered (width or length) 
the calculator will then populate the number of search legs and search leg ETI. 
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The Aircraft Req’d result is based on the Time required / available divided by the Task 
Hours. The task hours can be changed by selecting from a drop-down list. 
It is possible to store results from a calculation for comparison with further 
calculations using modified search parameters by clicking the Compare button (i.e. if 
there are insufficient aircraft to search the area at the optimum track spacing then 
conducting a review of the track space or search speed or area coverage). In this case 
do not use the clear button but adjust the parameters and re-calculate the results. 

 

 Advanced Calculator with Comparisons 
 
 

 Basic Calculator 
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TRACK SPACE CALCULATOR (AIR SEARCH) 
The Track Space Calculator returns the corrected sweep width, coverage factor and 
probability of detection results for visual searches over water and land in accordance with 
Tables I-5 and Tables I-6 in the NATSARMAN. Correction factors for search speed, weather 
and vegetation factors are also applied. 
 

  
User Guide 
 Select the Land Target / Maritime Target tab as appropriate 
 Select the search object from the list 
 Select the appropriate criteria from the drop-down options (Visibility, Weather etc.) 
 If desired, enter a Practical Track Spacing in the Track Space field (white background) 
 Read off the Search Parameters in the table 
 When using in conjunction with the Aviation Search module (WS2/3) select the row for 

desired search Height and click the Apply button to export to the Aviation Search module. 
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TRACK SPACE CALCULATOR (MARITIME SEARCH) 
The Track Space Calculator returns the corrected sweep width, coverage factor and 
probability of detection results for visual searches using maritime assets in accordance with 
Tables I-3 and Tables I-4 in the NATSARMAN. Correction factors for weather and observer 
fatigue are also applied. 
 
 

  
User Guide 
 Select the Search Asset type tab as appropriate (vessel or merchant ship) 
 Select the search object from the list 
 Select the appropriate criteria from the drop-down options (Visibility, Weather etc.) 
 If desired, enter a Practical Track Spacing in the appropriate eye height track (white cell) 
 Read off the Search Parameters 
 When using in conjunction with the Maritime Search module (WS8) select the row with the 

desired Eye Height and click the Apply button to export to the Maritime Search module. 
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INTERCEPT & ESCORT TOOLBAR 
The Intercept and Escort module is used to determine a point of intercept between two 
moving crafts. 
The Intercept and Escort calculator returns the Ground Position of Interception (GPI) latitude 
/ longitude, time of intercept and bearing / distance to the GPI for the escort craft.                     
                 

 
 

User Guide 
 Click the New button to start a new calculation 
 Enter the Target details; 

o Position (Latitude / Longitude) 
o Date / Time that the target was at that position 
o The Track and Speed of the target craft 

 Enter the details of the Escort (intercepting) craft; 
o Position (Latitude / Longitude) 
o Date / Time that the target was at that position 
o Wind direction and speed 
o Speed of the Escort craft 

 Select / de-select the Apply Wind to Target box as appropriate (do not apply to surface 
targets i.e. vessels / vehicles) 

 Click the Calculate Button to return the Intercept & Escort Results 
 

Tools 

  
 
Solutions 
 The intercept and Escort calculation can be send to a SARC_Map file to be viewed the SAR 
Calculator Mapping application (SARC_Map). 
 

Included in the Intercept & Escort module is quick access to the First-Last 
Light and Time Difference calculators to assist the SAR practitioner in 
planning. 
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GRID CONVERTER 
The Grid Converter provides functionality to convert between the Universal Transverse 
Mercator (UTM) Coordinate System and the Latitude Longitude Coordinate System. 
UTM results return the Longitude Zone and Latitude Band and the Easting / Northing 
coordinates to placement of 1m2. 
Latitude/Longitude results are returned as Degrees Minutes and Decimal Minutes. 
 

 Lat/Long to UTM 
 
 

 
UTM to Lat/Long 

 
User Guide 
 Click the Reset icon  to commence a new conversion  
 From the drop down list select the desired conversion type; 

o Convert Lat/Long to Grid (UTM); or 
o Convert Grid (UTM) to Lat/Long 

 Enter the known coordinates and associated details; 
 Click the Calculator icon to convert the coordinates  
 Read off the results in the answer field 
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CUMULATIVE POD CALCULATOR 
The Cumulative POD calculator returns the percentage value of the probability of detection 
following one or more search efforts of a particular area. The cumulative POD provides a 
measure of search integrity. For more information refer to the NATSARMAN Appendix I POD 
Graph. 
 
The calculator offers two methods: Auto and Manual. 
 
 
 

      
 
 

   
 
 
 
 
 
 

User Guide – Auto Method 
 Select the Auto Tab 
 Click on the + symbol and enter the individual 

Coverage Factor value 
 Repeat + for each search effort of the area 
 Click on the Calculate button to return the 

results for Average Coverage Factor (CF) and 
Cumulative POD. 

User Guide – Manual Method 
 Select the Manual Tab 
 Enter the average Coverage Factor (CF) value 

(i.e. add up all CF values and divide by the 
number of searches) 

 Enter the number of searches 
 Click on the Calculate button to return the 

Cumulative POD. 
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FUEL ENDURANCE CALCULATOR 
The Fuel Endurance Calculator is designed to assist in determining the available time that 
an aviation asset can provide on search, i.e. search endurance. The calculator also provides 
the option to automate the CASA CAAP fuel reserve recommendations into the calculation.  
Note: Fuel Endurance figures should always be confirmed with the operator / pilot. 
 

  
User Guide 
  Click the Clear Button to start a new calculation 
 Enter the Total (on-board) Endurance of the asset in minutes 
 Enter the Transit Out and Transit Back times in minutes (to/from the search area) 
 Enter the Variable and Fixed Reserve times in minutes * 
 Enter any Holding and/or Alternate transit times in minutes 
 Click the Calculate button to generate the Search Endurance result (in minutes) 
 
* If the applicable Resource details are chosen and the Auto Complete checkbox is selected then the 
reserve values will auto populate based on CAAP recommendations. 
 
Tools 
 Distance, Time, Speed Toolbar (DTS) 
 

  
 The DTS Toolbar is available from the DTS button to assist in calculating transit times (two 
of the values must be entered to calculate the 3rd value) 
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Area Allocation Function 
 

 The Area Allocation operation performs the function of worksheet 6, providing the following 
results: 

 Actual Search Hours available @ 120 knots (required for worksheets 2, 3 & 8) 
 Maximum Area / Track miles that can be searched 
 Allocated Search Legs and Area SQNM 

 
 

  
User Guide 
  After performing a Fuel Endurance calculation click the Area Allocation Button 
 The Search Endurance value will be imported and a calculation performed on the Actual 

Search Hours, less 15% (for turns and investigation) 
 Enter the Search TAS, Track Spacing and Search Leg distance  
 Click the Calculate button to determine the maximum number of search legs that the 

aircraft can accomplish   
 Enter the number of search legs to be allocated to the aircraft (equal or less than 

calculated Maximum Search Leg value) 
 Click the Calculate button to determine the Allocated Area SQNM 
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10. TOOLS 
This module provides access to a variety of tools to assist the SAR practitioner.  Included 
are; 
 Zone Clocks 
 SARC_Map 
 Bearing\Distance tool 
 First-Last Light tool 
 Time Difference calculator 
 Computations 

 

  
 
 
 
 
 
 
 
 
 
 
 
 

Access to the Tools module is achieved by clicking on 
the ‘Tools’ menu item on the SAR Calculator floating 
window. A list of available tools will be presented. 
Double clicking on a desired tool will open it in a 
separate window. 
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ZONE CLOCKS 
The Zone Clocks is a floating toolbar that provides access to a number of regional time zone 
clocks and other time related tools. 
 

 
 
Features 

  Sets display to 12 hr or 24 hr clock format 
  Displays a table detailing the first-last light times associated with the capital centres 

of the zone clocks being displayed 
 Displays a comparable time grid based on the zone clocks being displayed  
 Opens a Timer / Stopwatch toolbar 
 Scrolls through the available sets of Regional Zone Clocks: (Australia; SRR; Pacific 

Islands 1; Pacific Islands 2, Indian Ocean) 
 Changes the orientation of Zone Clock Toolbar between Portrait and Landscape 

 
Tips 

 Single clicking on a clock will highlight the time for ease of reference 
 Double clicking on a clock will allow the user to enter a specific time for that zone to 

compare to the associated time values for the other regions being displayed 
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SARC_Map 
SARC_Map is an extension of the SAR Calculator designed to provide the SAR practitioner 
with a visual presentation of developed Search Areas and Drift Plots. To take full advantage 
of the SARC_Map features an internet connection is required. 

 
 

Location Bar 
Enter an address in the location bar to zoom the map display to zoom to that location.  
The title of an active search plan will be displayed to the right of the Location Bar. 

 
 

Tools 
Map View 

 
 
 
 

The Map View tools provide the user with control over the map display.  
Three map views are available:  
 Map (default)  
 Earth (satellite)  
 Nil (hide map checkbox)  
 Zoom Level: zooming can be controlled by the Zoom slide bar or the mouse-wheel. 
 

 Map Panning: The Left mouse button (default) allows the map to be panned (moved). Click on the Pan symbol to change to the right mouse button.  Note: during some operations the pan is atomically changed to the right mouse button. 
 Selecting the Mark command button allows interaction with the map display to mark a location. The Map Marker checkbox will hide / unhide the map marker display. 
 The current mouse position coordinates will be displayed in the Coordinate field. 
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Search Plan Tools 

 
Legend displayed as appropriate  to loaded Search Plan file  
Bearing and Distance Tool 

  
 

 

The Search Plan Tools control the files that have been created from the SAR Calculator application.  
Opens a Search Plan file from file explorer 
Loads all Directory mapping files into the Map pick list 
Opens the selected file in the Map pick list 
 Captures a screen shot of the current mapping display 
 Clears the Map pick list 
 Closes any active Search plans and resets the display 
 Zoom/pans to the active Search plan  

The Bearing & Distance Toolbar provides interaction with the mapping display to measure the distance and bearing between two points.  
 

  Selection of the From/To buttons will allow mapping interaction. The position selected on the map display will be captured.  
 Calculates the Bearing and Distance 

 Clears the previous calculation result  
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BEARING & DISTANCE TOOLBAR 
The Bearing\Distance Toolbar calculates the bearing and distance between two sets of 
waypoints or a waypoint based on a bearing & distance value. The calculator requires two of 
the three fields to be completed in order to calculate the remaining value.  
 

 
 
User Guide 
 To calculate WPT 2 coordinates; 

o Enter a  Lat/Long in WPT 1 fields; 
o Enter a Bearing & Distance 
o Click the Calculator icon to return the WPT 2 Lat/Long result 

 
 To calculate WPT 1 coordinates; 

o Enter a  Lat/Long in WPT 2 fields; 
o Enter a Bearing & Distance 
o Click the Calculator icon to return the WPT 1 Lat/Long result 

 
 To calculate the BRG/DIST between WPT 1 and WPT 2; 

o Enter a  Lat/Long in WPT 1 fields; 
o Enter a  Lat/Long in WPT 2 fields; 
o Click the Calculator icon to return the BRG and DIST result 

 
FIRST-LAST LIGHT CALCULATOR 
The First-Last Light Calculator displays the applicable daylight times for the location and 
date entered. If it is the current date then the remaining light will also be displayed. 
 

 
 

Note: This tool also interacts with the Maritime Drift and Intercept & Escort modules by 
automatically importing the location and date fields. 
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TIME DIFFERENCE CALCULATOR 
The Time Difference Calculator will compute the time difference between two date/time 
groups. The results can be displayed as a specific unit only or to a preciseness of units 
ranging from years to minutes.  

 
 

  
User Guide 

 Click the Clear button to reset the calculator 
 Complete a start date, hour and minute 
 Complete an end date, hour and minute 
 Click the calculate button to return the result 
 To change the preciseness of the result, select the desired base level (i.e. Days or 

Minutes etc) 
 

Tip: if the calculation is to include a current time select the time format (UTC or Local) from the Time 
Zone Now drop-down list and click the Now button to automatically populate the From or To fields. 
 
Note: When used in conjunction with the Maritime Drift module the LKP DTG will be imported 
into the Time Difference Calculator ‘From’ DTG fields. After performing the calculation the 
result can be exported into the Maritime Drift ‘Hours of Drift’ field by clicking on the Export 
button. 
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SAR COMPUTATIONS 
The SAR Computations module provides access to a variety of functions, including; 
 Unit Converter 
 Area (square nm) calculator 
 Wind Vector calculator 
 Pressure Height calculator 
 Descent Point / Profile calculator 
 VHF Signal Range calculator 
 ATVS Calculator (basic) 
 Rate of Search Leg Creep calculator 
 Radius of Turn Calculator 
 Coordinated Creeping Line calculator 
 Distance to Horizon calculator 
 
 
 

  
 
The SAR Computations module is designed to be intuitive. In most cases it just requires 
entering or selecting the required field values and pressing the calculate button to return a 
result.  
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11. RESOURCES 
Selecting the Resources button from the main floating menu will allow double-click access to 
a number of supporting resources. These include; 
User Guide:   A quick reference to the features included in the SAR Calculator 
NATSARMAN:  Internet link to the National Search and Rescue Council website* 
SAR Training:   Web link to the SAR Training Australia website* 
SAR Weather:  Web link to WINDYTY weather information website* 
SAR Contacts:  Web link to the Search and Rescue Contacts search webpage* 
User Manual:   Opens the SAR Calculator User Manual 
* Requires an active internet connection. 
 
12. PREFERENCES 

 

    
 
Preferences allow the user to customise the SAR Calculator application. The following 
values can be set as the settings; 

 Zone Clock Region 
 Clock Type (12 or 24 hour) 
 Latitude Zone 
 Longitude Zone 

Right-Click on the SAR Calculator Menu to access the 
Preferences and About information 
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Preferences 

 
 
The “Resource Links” button allows the user to customise the shortcuts to Websites. 
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 13.  SAR Calculator Disclaimer 
 

The SAR Calculator application has been designed as an aid which may assist SAR practitioners with search planning calculations consistent with accepted Search and Rescue procedures and practices, and the methodologies adopted in the Australian National Search and Rescue Manual. 
This training aid does not replace the skill, formal training and knowledge of a qualified Search Mission Coordinator (SMC), and should not be relied upon as a primary SMC decision making tool.  
The user indemnifies and releases SAR Training Australia, its officers, employees and agents and the developer of the SAR Calculator in respect of all claims of liability for loss, damage or injury which may be suffered by any party or person, direct or consequential arising from the use or   of the SAR Calculator.   
The software is provided on an 'as is' basis with no ongoing support. SAR Training Australia does not warrant or guarantee the serviceability, accuracy, completeness, currency or suitability of the SAR Calculator for any purpose or use, including complying with any applicable statutory obligations arising in any jurisdiction. 
Search planning calculations that are derived from this software should always verified as correct with approved Search and Rescue manuals and procedures.  

 
  

SAR Calculator 


